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needle notes
Summer has fi nally arrived all around the country, making memories of all the 

record snows of the winter of 2009-2001. After fi nishing our spring cleaning and 

tossing out all of the out-of-date and non-repairable items in our households, I think 

it’s time to create some new fashions for our homes and ourselves, don’t you? This 

issue of Through the Needle includes instructions for an embroidered table runner, 

appliquéd placemats, a beautiful blouse with embroidered insertion lace, and much 

more. Get prepared to create some incredible projects! 

The change of seasons reminds us that all things must change, and in keeping 

with this philosophy, we have an announcement: This is the fi nal print issue of 

Through the Needle – but it’s not the end! Our new Through the Needle Online will 

debut in July 2010. It will have the same quality content you’ve come to know 

during our eight years in print and you’ll fi nd fun things to make and informative 

sewing lessons in every issue, no matter what your skill level. The three things that 

will change about Through the Needle are how you receive it, when you receive it, 

and what you pay for it. There will be six issues instead of four and you’ll read it 

online – for FREE! 

The new online version of Through the Needle will be similar to the print 

version, right down to your ability to “turn” the pages. In addition, the new 

online version will take up less storage room than the print version and will be 

available anywhere you have a computer with Internet access. Plus, it will have 

features the print version could never have: a live Table of Contents (click on the 

title and automatically fl ip to the article), searchable content (enter a keyword and 

be taken to every occurrence of the word in that issue), and live links that take you 

to related websites. Going online opens up loads of options that make it easier for 

you to use and enjoy every issue of Through the Needle Online. In addition, we’re 

going green – think about the amount of paper and ink that will be saved by not 

printing a paper magazine! 

Through the Needle Online will be available at www.berninausa.com starting 

August 1, and beginning July 1 you can sign up to automatically receive e-mail 

notifi cation and links to each new issue. 

I’ve been involved in the production of Through the Needle magazine since it’s 

beginning in 2002, and it’s exciting – and a little scary! – to take it to this new 

venue. We know this change will make our magazine available to more readers, 

encouraging them to stretch their sewing knowledge and inspiring them to reach for 

new creative heights. We also hope that it strengthens the connection we have with 

you, our current readers, making our latest sewing information more interactive and 

more accessible for your stitching pleasure.  

Would you like to see your project or sewing-related article in Through the Needle 

Online? Send your ideas to jo@berninausa.com; please include a photo and 

general description. We can’t promise to use every idea, but we’d love to see 

what our readers have been making and will defi nitely consider each submission 

for publication.

Thank you for eight years of support for Through the Needle, and we hope you will 

join us as we enter the digital age with Through the Needle Online!



Hearts… Silk… Thread… Quilt…
Sarah has been sewing since she was six years old, making clothes for herself and 

others.  She then went on to earn a PhD in Computer Science.  After a brief career as 

a Software Engineer, she turned her passion to quilting. This love of quilting, sewing 

and technology has culminated in fantastic creations for the embroiderer and quilter 

alike.

Hearts
Hearts is a collection of 18 beautiful designs, each in three sizes (4", 6" and 9") 

that can be used on quilts, bags, pillows. Just let your mind wander to all the 

possibilities.  Each design is an original work of art from Sarah herself.

Silk Hearts Fabric Collection
No need to search for the right fabric to make the wonderful Hearts quilt top (also 

found on the design CD).  This collection of silk has been gathered to perfectly 

complement the Aurifi l Thread Collection.  The fabrics are silk dupioni—soft to the 

touch with just enough shimmer to refl ect the light in a warm glow.

Silk Hearts Thread Collection
We were not the only ones to fall in love with this collection. Aurifi l also saw the 

talent in the designs Sarah devised and in response to this popular theme and 

distinctive look they developed Heart’s own thread collection.  This includes 12 large 

spools of Cotton Mako 50 wt thread to coordinate with the Hearts CD and the Silk 

Hearts Fabric Collection.

Quilt!
Combine all three and what do you have? The perfect set to create a quilt that will 

wow your friends, family and even you!  

So… what are you waiting for?  Go to your favorite quilt shop and ask for the Hearts 

Collection today.

spotlight on…

Silk Hearts Fabric 
Collection

Hearts Embroidery 
Applique CD

Silk Hearts Collection 
from Aurifi l

Silk Hearts 
Quilt Top



4

T H R O U G H  T H E  N E E D L E

Floral Vision’s
         Wreath Block

BY SUSAN FEARS

OESD’s Floral Visions Design Collection features a beautiful array of fl oral 

and lace designs that work together as singles or in combinations. This 

collection of designs not only makes a stunningly beautiful quilt, but can 

also be easily used on pillows and other coordinating accessories. 

The Floral Visions Quilt shown here has eight blocks plus a center medallion. 

This article contains instructions for creating Block One. The embroidery 

is easily stitched in one hooping using the BERNINA 830 and Jumbo 

Hoop, but may also be embroidered using other models by splitting 

the design into sections with the Multi-Hooping function. Visit 

your BERNINA dealer for step-by-step lessons to make this 

entire Baltimore Album-inspired quilt! 

Supplies

• OESD’s “Floral Visions” Crafter’s Collection #001
• BERNINA EditorPlus or DesignerPlus Embroidery 

Software
• BERNINA 830 sewing & embroidery system or other 

embroidery system
• BERNINA Jumbo Hoop
• 1 yard cream cotton 
• ¼ yard yellow cotton
• ½ yard of fusible batting
• Ultra Clean & Tear stabilizer, 15” x 10 yards
• Isacord polyester embroidery thread – colors available 

in Floral Visions Thread Collection Tin
• Superior Threads’ Bottom Line bobbin thread
• Titanium Organ Embroidery needles, size 80
• Walking Foot #50
• Patchwork Foot #37/37D OR Patchwork Foot with 

Guide #57/57D 
• Quilting gloves, such as Machingers 
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Designing the Embroidery

Select File > Open > Design #34. Click on the design to select it.

Zoom out at least two times by using the scroll mouse (v6 
only) OR by selecting View > Zoom > Out 2x OR by using the 

Zoom icon.

Click on the Wreath tool and select 5 from the drop down 
menu.

Drag the cursor to the center of the screen, forming a wheel with fi ve 
spokes radiating out from the center. Click to set the wheel.

Select File > Insert Design > Design #4. If it is not already selected, 
click on it.

Click on the Mirror Horizontal icon.

Right click one time on the Rotate icon to rotate the design 45° to 
the right.

Move the fl ower so that it sits between two spokes of the wheel and 
sits a little taller than the pink fl owers.

With the blue fl ower selected, click on the Wreath tool and select 5 
from the drop down menu. Click when the new wreath sits within the 
previous wreath.

The design should measure approximately 9.9” x 9.9”. This is within the 
10½” embroidery fi eld of the Jumbo Hoop. If the design is larger, use 
the Undo command and make the wreath layouts tighter and smaller.

Note: If not using a BERNINA 830 with Jumbo Hoop, use the Multi-
Hooping function to split the design in to pieces that will fi t into your 
largest embroidery hoop.

Use File > Save As to save the design as Floral Visions Block 1.art.

To send the design to your embroidery machine, click on the 
Machine Write icon and follow the prompts for the appropriate 
embroidery machine or USB media.
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Embroidering the Block
Fuse batting to an 18” x 22” rectangle of cream fabric and hoop with 
two layers of Ultra Clean & Tear stabilizer.

On the BERNINA 830, select the Color Resequence icon to combine 
some of the color changes.

Embroider the block and remove excess stabilizer. 

Trim the embroidered block to 11½” x 11½”.

Cutting & Piecing the Block

Note: Use Walking Foot #50 to piece the fabric-only units to the 
embroidered center with batting. When piecing fabric to fabric, use 
the Patchwork Foot of your choice (Patchwork Foot #37/37D or 
Patchwork Foot with Guide #57/57D). 

Trim the embroidered center block to 11½” x 11½”.

Cut two 1½” x 44” strips of yellow fabric to be sub-cut as needed.

Cut one 9½” x 11½” rectangle of cream fabric.

Piece yellow strips to the long sides of the cream rectangle.

Cut this pieced strip into four 2½” x 11½” sections.

Cut four 1½” x 11½” strips from the long yellow fabric strip.

Sew a 1½” x 11½” yellow strip to each 2½” x 11½” section.

Cut a 3½” x 16” strip of cream fabric and cut four 3½” x 3½” 
squares from it; discard the excess.

Piece two 3½” cream squares to the short ends of the two combo-
units from the previous step. 

Sew two yellow-cream units to opposite sides of the 11½” x 11½” 
embroidered square.

Seam the three pieces together to complete the Wreath Block.

Instructions for Making a Wall-Hanging Using Block One

Fuse strips of batting to the areas around 
the embroidered center block.

A   x the backing to the wrong side of the pieced top 
using 101 Quilt Basting Spray.

Thread the machine with Masterpiece Quilting Thread in the 
needle and bobbin.  Attach the BERNINA Stitch Regulator 
#42 or Freehand Quilting Foot #29/29C. Lower the feed dog 

(the BERNINA 830 will lower the feed dog automatically 
when the BERNINA Stitch Regulator is attached).

Quilt and bind the block as desired.



The ultimate learning experience for quilters includes:  21/2 days of learning—everyone 
attends all sessions; exclusive 120-page color syllabus; no supply list—no sewing; fabric shopping; 
a quilt show featuring works from Ricky, Alex and Libby; and more! Registration fees are based on 
registration deadlines and group size as indicated on the registration form.

“Two and a half days of seminar sitting without sewing/hands-on activities? Yes! What an absolutely informative and inspiring experience!”

Sponsored in part by

Ricky Tims with special guests
Alex Anderson and Libby Lehman

Rocklin, CA
(Sacramento metro area) 
June 24–26, 2010

Hyannis, MA
(Cape Cod area)  
September 2–4, 2010

Jacksonville, FL
January 13-15, 2011

Registration forms and complete details are at www.rickytims.com



Complete this quick and easy project in one
evening! Use a “mock hand quilting stitch” for
your sashiko stitching. It’s easy to create this
stitch on your sewing machine using the Long
Stitch function and following the instructions
in this article. Using fabric with a pre-printed,
wash-away sashiko design eliminates the need
to mark the fabric.

Supplies
•  Pre-printed 100% cotton Japanese Sashiko fabric kit

(sample is Nejiri-ume & Asa-no-ha)
•  Batting (cut to fi t kit fabric)
•  505 Adhesive Spray
•  OESD Ultra Clean & Tear Stabilizer
•  Open Embroidery Foot #20/20C/20D
•  Mettler 60-weight cotton embroidery thread, white and a

color a shade darker than the kit fabric
•  Titanium Sharp needle, size 90/14

Sashiko (pronounced shash-ko) literally
means “little stabs,” and is a form of

decorative reinforcement stitching – or
functional  embroidery – from Japan.

Traditionally used to reinforce points of
wear or to repair worn places or tears

with patches, this running stitch technique
is now often used for purely decorative

purposes in quilting and embroidery. The
white cotton thread on the traditional

indigo blue cloth gives sashiko its distinctive
appearance, though red thread is sometimes
used on decorative items. There are many
traditional sashiko patterns, some of them
representational in a stylized way, such as

tortoise shell, waves, and lozenges.

Quick & Easy

Sashiko
BY AMANDA WHITLATCH
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Program the Sashiko Stitch
There are two components to sashiko stitching: the
straight stitch and the gap between the stitches.

Select the straight stitch and set the stitch length at
0.5mm. Engage the Long Stitch function and change the

needle tension to 10.

Add this stitch to your Personal Program, so the adjustments need
only be made once. Do this by clicking on the Stitch Altering Area,
then clicking on the Save to Personal Program icon.

Open Combi-Mode, open Personal Program, and select the
shortened straight stitch three times.

Return to the Practical Stitch Menu and select the regular straight
stitch. Set the stitch length at 3.5mm and engage the Long Stitch
function (leave the tension at its normal setting).

Note: All four straight stitches will look the same in the Stitch
Combining Area.

If your machine does not have a long stitch function,
you can still create a sashiko-like stitch. Select a

straight stitch and increase the length to 4mm. Insert
a Topstitch needle and thread it with topstitching
thread or cordonnet. Use Cordonnet Foot #11 for

sewing sashiko, as the groove in the sole provides room
for the heavy thread to move easily under the foot.

Test the Sashiko Stitch
Select a dark cotton fabric and place it over a layer of batting. Place
a sheet of OESD Ultra Clean & Tear Stabilizer under the batting and
use 505 Adhesive Spray to temporarily attach the layers.

Insert a Sharp needle into your machine and thread it with 60-weight
cotton thread in a color that matches your fabric. Fill the bobbin with
white 60 weight cotton thread.

Attach Open Embroidery Foot #20/20C/20D; the open toes
provide great visibility. Engage the BERNINA Dual Feed on 8 Series
machines.

Test the sashiko stitch on the fabric/batting/stabilizer, sewing straight
lines and curves.

Stitch the Sashiko Panel
Place the sashiko kit panel – printed side up – over a layer of batting.
Place a layer of OESD Ultra Clean & Tear Stabilizer under the batting
and use 505 Adhesive Spray to temporarily attach the layers.

Test the stitch as described above.

Sew along the printed
lines, forming – as much as
possible – a continuous line
of stitches.

There are many ways to
use your completed sashiko
panel – as a pillow front as
shown here, as a garment
panel, or as one side of a
tote bag, to name a few.
You can also join several
squares together to make a
quilt top.
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Fabric and Notions
•  “Mimosa Top & Pant Pattern” by The

Sewing Workshop
•  2 to 2½ yards of dress-weight linen,

determined by size selection
•  Ribbons and trims*:

-  3 yards each: assorted ribbons (sheer,
woven, varying widths)

-  1 yard each: assorted trims (rickrack,
simple lace designs)

•  Mary Ellen’s Best Press
•  Extra-fi ne Fusing Tape by Project Sewing

Workshop
•  Perle Cotton Thread #5 for pintucking
•  Isacord Embroidery Thread for decorative

stitching
•  Metrosene polyester thread for garment

construction
•  Microtex/Sharp needle, size 80
•  Twin needle, size 2.0/80
•  BERNINA Feetures Volumes 1-3

Equipment & Accessories
•  BERNINA sewing machine
•  Zigzag Foot #0
•  Edgestitch Foot #10/10C/10D
•  Braiding Foot #21/12C
•  Open Embroidery Foot #20/20C/20D
•  7-Groove Pintuck Foot #32
•  Clear Foot #34/34C

* When shopping for ribbons and trims,
select a variety of color values, shapes and
widths that will complement your base
fabric. Include several sheer ribbons for
layering. Don’t be afraid to wander outside
the box to add an unlikely choice to the mix.

Layout and Cutting
Before cutting out the pattern pieces from
the linen fabric, identify which pattern pieces
will be embellished and set them aside.
For the Mimosa Top as shown, set aside
the Upper Front Band and the Lower Front
Band for embellishment.

Peek into the designer department at any specialty 
department store and you’ll fi nd garments 
created out of beautiful fabrics enhanced 

with rich coordinating trims and brocades.  The 
trims are often the piece de resistance that makes these 

garments so outstanding. As sewers we have the tools to create our 
own unique trims using BERNINA specialty feet and the built-in 
decorative stitches on our BERNINA sewing machines. Project Sewing 
Workshop offers a bounty of patterns and fabrics ideal for garment 
embellishment. Featured here is the Mimosa Top with an embellished 
front band, but these techniques can be applied to any pattern. Consider 
adding embellishment trims to garment collars, cuffs, yokes, or even 
exposed facings to take your garment project to the next level.

BY CATHERINE GROSS

Creating Accent Trims:
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Lay out the remaining pattern pieces and
cut them from the linen fabric; set aside.
For the pieces to be embellished, rough-
cut the pattern piece shapes, adding
approximately two extra inches in both
width and length. You will embellish these
pieces and then cut out the pattern pieces
precisely.

Embellish the Band
Now the fun begins! This recipe calls for a
combination of ribbons and trims, layered
and interspersed with pintucks for added
texture.

Use Mary Ellen’s Best Press to stabilize the
linen fabric prior to embellishment.

To embellish each accent piece, start at the
center of the piece and work outward in
both directions.

For the Upper Front Band, two sheer
ribbons (1” and 5/8” widths) were layered
and positioned at the center back of the
band as the anchor row.

Tip: To prevent wide ribbons from shifting
during stitching, fuse them in place with
Extra-Fine Fusing Tape prior to stitching.

Using Open Embroidery Foot #20, stitch
layers of ribbons together with decorative
stitches. The open area between the toes of
this foot gives a clear view of the needle and
stitching area.

Make pintucks (three to fi ve rows) between
the ribbons to create design interest and
texture. Alter the thread combinations when
creating pintucks to create an ombre effect.

Use 7-Groove Pintuck Foot #32 to create
rows of pintucks in dress-weight linen.
Seven 1.3mm grooves run the length of the
foot sole to aid in the formation of perfectly
spaced parallel pintucks.

To make the pintucks, use a 2.0/80 Twin
needle, two needle threads, and perle
cotton #5 as a fi ller cord to create a raised
effect. Thread the perle cotton cord from
below the stitch plate through the single
hole located in front of the needle opening.
(To aid in threading the cord through the
hole, lower the feed dogs and remove the
stitch plate. Replace the stitch plate and
raise the feed dogs once the cord is in
position. Take care not to catch the cording
on the feed dog teeth.)

Tip: If using an 8 Series machine, use the
Pintuck Attachment included with your
machine to position the fi ller cord instead of
following the procedure described above.

When stitching pintucks, be sure to pull the
fi ller cord under the fabric and toward the
back of the machine, ensuring that it will
automatically be encased by the bobbin
thread. Experiment with tightening the
needle tension for a more raised effect.

Use Edgestitch Foot #10/10C/10D to stitch
single ribbons in place. Move the needle
position 2 to 3 positions to the left and
straight-stitch the ribbons in place. The
center guide of the foot will ride against the
ribbon edge, keeping the stitching straight.

Use Braiding Foot #21/12C to stitch narrow
1/8”-wide ribbons in place. Thread the narrow
ribbon through the beveled opening in
the front of the foot. A guide in the sole of
the foot holds the ribbon in place. Use a
decorative stitch for added interest.

Use Clear Foot #34/34C to embellish
ribbons with reverse motion decorative
stitches. The sole of the foot is indented in
front of and behind the needle slot, allowing
these stitches to move freely forward and
backward. This translucent foot with red
center needle markings aids in accurate
stitch placement.

Continue to alternate ribbons and pintuck
embellshments until the entire surface of the
fabric is covered.

Cut one Upper Front Band and two Lower
Front Bands from the embellished fabric
pieces.
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Construct the Top
Following the pattern directions, stitch the
bands together and complete the top using
Zigzag Foot #0 for the construction.

For added interest, add a ¼”-wide sheer
ribbon to the hemline of the top. Stitch
in place using Edgestitch Foot #10, and
embellish with a decorative stitch using
Clear Foot #34.

Complete the look with a fun button closure
enhanced with ribbon trims.

Pair the Mimosa Top with the “Trio
T-shirt” by The Sewing Workshop as
shown with the “Mimosa Top.” Both
patterns are available through Project
Sewing Workshop. Tips and tricks for
making the “Trio T-shirt” can be found at
www.berninusa.com > In the Spotlight >
Project Sewing Workshop.
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Perfect Mitered Corners
BY LINDA LEE

As with most ready-to-wear clothing today, many garments
in the Project Sewing Workshop program are unlined and the
wrong side of the fabric may show. Such is the case with the
front and side hems of the Mimosa Top (see article on page 10)
and the front drape of the Lotus Skirt.

Because you see the wrong side of the fabric, the hems and
corners need to be fi nished neatly. That can be accomplished
by using pressing templates made out of tagboard (such as a
manila fi le folder).

To make perfect mitered corners:
Cut one template the width of the fi nished hem by about
12” long and another template ½” narrower than the
fi nished hem.

Place the wide template on the wrong side of
the fabric. Press the fabric over the edge of the
template, matching the raw edge of the fabric to
the edge of the template. Press through all layers.

Open the fabric and place the edge of the narrow template
along the pressed crease. Turn and press ½” over
the edge of the template as shown. Repeat for the
adjacent hem. Press the adjacent hems in place.

Place one pin in the hem allowance only, perpendicular
to the hem fold. Place a second pin in the opposite hem
fold at the intersection of the two hems.

Open out the folds, keeping the ½” turndowns
in place. With right sides together, match the
pins at the folded edges. Mark a diagonal line
from the pins to the point where the crease
meets the diagonal fold. Sew from the pins to
the point, backstitching at both ends.

Trim the seam allowances to ¼”.

Press the seam open. Turn right side out and
press again.

Topstitch the hem in place. Use Edgestitch Foot
#10/10C/10D for perfectly placed stitches along
the edge of the fold.

The Lotus Skirt is easy to make and requires only two yards of fabric for any size. The
one-piece skirt attaches to a two-piece shaped yoke – just three pattern pieces in all.
The Lotus Skirts pictured below are available as kits from your local Bernina dealer.
Each kit contains a pattern that includes all sizes, and enough fabric to make any size.

Photo #1
Fabric – 100% linen stripe in
burnished red and gold

Photo #2
Fabric – 100% rayon reversible paisley black and cream stripe

Photo #3
This mitered hem technique and
six more are included in Mastering
Miters by Linda Lee, also available
from your BERNINA dealer.

Photo #4
Project Sewing Workshop Kits

Get the latest fashion sewing
information – visit
www.ProjectSewingWorkshop.com
to sign up now!Photo 1 Photo 2

Photo 3

Photo 4



Photo by Gregory Case 
Photography.
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M. Butterfly Kimono
BY MUNA ELIAS

One beautiful spring day my 
telephone rang. As I picked up 
to answer the call, little did I 
know that this would be the fi rst 
of dozens of calls in the next 
six weeks from a local artist, 
Fumiko Bielefeldt. She was 
seeking someone who could 
capture the essence of her 
painting of an elegant butterfl y 
and render it in thread art. This 
thread-painted butterfl y appliqué 
would ultimately grace the back 
of a traditional Japanese man’s 
wedding kimono to be worn by 
the main male lead character in 
a production of M. Butterfl y.

Needless-to-say, this out-of-the-blue request 
intrigued me. I truly admired the 4” x 6”
image Fumiko had sent me via e-mail. 
Could I thread-paint an elegant butterfl y 

with such detail within the specifi ed 6-week 
time frame? I must admit that I was fl attered 
to be asked to participate in the creation 
of a garment for this play being staged by 
TheatreWorks in the San Francisco Bay 
area. 

I met in person with Fumiko Bielefeldt and 
the costume department team and saw, 
for the fi rst time, the scale of the project. It 
was going to be stunning. I agreed to create 
the design in thread for two reasons: First, I 
loved the challenge of translating an image 
from just paint swatches and a drawing and 
into thread. Second, I knew that if I could 
capture that image in fi bers, it would be 
breathtaking. I recognized the challenge 
as a wonderful opportunity for me as a 
textile artist. And besides, I had BERNINA 
machines – “Hey, no problem!”

I already knew many things about thread 
painting, but, admittedly, with this project I 
learned much more. To meet the challenge, 
I spent 12 to 14 hours a day at my machine, 
painting with a glorious thread palette. Little 
did I know that I would ultimately spend 
over 400 hours sitting in front of my trusty 
BERNINA machines!

Creating the Panels

The production company was made up of 
consummate professionals, including a crew 
for scaling the size of the painted butterfl y 
to the exact proportions and size for an 
authentic wedding kimono. We worked as a 
team to plan the construction and fi nal look 
of the three-piece kimono. One of the major 
challenges? The thread-painted butterfl y 
sections must create one visual whole, even 
though the kimono panels weren’t even 
joined. 

As I completed each section of the 
embroidery, I gave it to the costume team 
and they constructed the kimono silk panel. 
While they worked on one panel, I continued 
on with the next one – without having the 
previous one as a reference for matching 
the elegant lines of the design. That made 
it imperative to follow my own sketches 
– precisely! The fi nished wedding kimono 
would be viewed onstage by the audience, 
so the beautiful butterfl y image needed 
to be clearly defi ned. Attention to color 
shading and thread refl ection all played into 
the creation of the butterfl y panels. 

Original design by Fumiko Bielefeldt.

Beginning the sleeves. Muna Elias. Photo by Jill Bowers.
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In the midst of all this creative challenge, 
I learned I was pregnant! Now I was not 
only creating a beautiful butterfl y garment; 
there was also a new life growing within 
me. Morning sickness! Oh, no! I had no 
time for this! With crackers at my side 
for queasiness, I continued sewing with 
diligence. 

Though the work was tedious, and I was 
often fatigued by the hours that I was 
putting in, stitching the butterfl y embroidery 
was a smooth process. I have the good 
fortune to own two BERNINA workhorses: 
an artista 200E and an artista 730E.  And, I 
know threads, I know tension controls, and 
I certainly know my BERNINAs. My reliable 
machines never let me down, even when 
working with sensitive metallic threads. 

After four hours of sewing with pedal to the 
metal, I would stop, change the needle, oil the 
machine, and let it rest, while I continued working 
on the embroidery with my other machine.

As I worked on the butterfl y appliqué, my 
fi rst question, “What was I thinking?” was 
soon replaced by the thought, “I’m making 
this happen!” 

A Learning Experience

I learned so much during the execution of 
the butterfl y, including what a difference the 
choice of thread weight could make; how to 
shade with colors; how to work with metallic 
threads; the importance of using the correct 
needle for each thread and fabric; and how 

to adjust the tension for metallic threads 
and silk fabric in a matter of seconds. The 
completed butterfl y appliqué required over 
400 hours of thread painting and the result 
was a beautiful work of art that I had never 
dreamed of creating. During this process, I 
totally “came out of the box” and reached a 
new level of comfort with my thread-painting 
ability and wonderful BERNINA machines.

During the opening night performance, the 
theater darkened and a single spotlight 
illuminated the butterfl y kimono as it came 
into view on-stage. The audience gasped 
as the light shone on the wedding kimono, 
revealing the butterfl y’s sheer elegance and 
beauty. I was thrilled with the response, 
as this was my fi rst view of the completed 
kimono. From concept to stag, in just 
six weeks, the project was a wonderful 
challenge to my creative ability and I am so 
very proud of my accomplishments. 

P.S. The following spring I gave birth to our 
healthy baby girl.

Embroidery almost done! Muna Elias and Fumiko Bielefeldt. Photo by Jill Bowers.

Francis Jue as Liling. Photo by David Allen.

Tips for Free-Motion Thread Painting
From this process I learned that I really, really love working with textile 
fi bers. While traditional quilting is gratifying, the artistry of painting with 
threads is especially satisfying and fulfi lling. I have since made art quilts 
using a variety of textiles, including hand-dyed silk and batting, paper, 
yarn, copper and other metals, buttons, and anything else I can get my 
hands on!

Here are a few hints that will help you with your next free-
motion stitching project:

Remember to relax and breathe. 
• Relax your shoulders and your hands. Stop to shake your hands out 

every few minutes, to prevent you from holding onto your fabric with 
a death grip. Tension shows up in the stitching.

• Don’t hold your breath – remember to breathe, breathe, breathe!

Set up your machine for successful thread painting.
• Lower the feed dog.
• Use the right needle size and type for your thread and fabric. I used a size 

90/14 Topstitch needle because I was using primarily metallic threads.
• Adjust tension as needed. For metallic threads I dropped the needle 

tension to 1.5.
• Change the needle after every four hours of stitching.

Practice, Practice, Practice!
• Make a quilt sandwich using a backing fabric, batting, and a top layer 

of fabric.
• Use a pencil to doodle a continuous design. 
• Using the correct thread, needle, and tension, stitch along the line 

you just drew, following your doodle design to your best ability. 
• Keep practicing and you will soon be on your way to creating your 

own free-motion quilting art. 
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At four years old, Muna began cutting up her mother’s dish towels and creating fashionable outfi ts for her dolls. Her need 
to create and design has never stopped. She enjoys every aspect of the creative process, from concept to completion, and 
fi nds ways to incorporate her love of fi ber art into her daily life as well as the lives of her young children. Muna is a member of 
SAQA, Visions Art Quilt Gallery, Textures Fibers Artists, Quilts on the Wall, and BERNINA Club of San Jose. See more of her 
work at www.MEbyMuna.com. 
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BY DEBRA RUTLEDGE

This project was inspired by three incredible tools for
creating quilts. The fi rst is my set of Nifty Notions®

“Cut for the Cure” rulers. Kaye England designed these
rulers to make precise cutting incredibly easy, which is a
huge help in making corners meet in patchwork piecing.
The second is the BERNINA Quilter program found in
BERNINA Embroidery Software, which allowed me to
design a virtual table runner before I stitched and cut it.
The software even creates templates for the placement!
Last, but certainly not least, is the Jumbo Hoop for the
BERNINA 830, which provided me with the freedom to
stitch these extra-large designs with ease.

Supplies
Embroidery Designs
•  OESD Signature Collection Fun with Minkee Gelato #12184

-  Design # CM101 Minkee Appliqué Flower
-  Design # CM102 Minkee Appliqué Flower 2

• OESD Signature Collection Elegant Line Quilting 3 #12135
-  Design # BD422 Dream Quilt Triangle

Fabric
•  2 yards of dark denim
•  16” x 45” rectangle of lightweight batting

Sewing Tools
•  Nifty Notions® “Cut for the Cure” Rulers

-  7” x 24” Rectangle Ruler
-  11” Square Ruler
-  Quarter Square Ruler
-  Half Square Ruler

•  4” embroidery scissors
•  Rotary cutter and mat
•  Target Stickers by Designs in Machine Embroidery
•  Embroiderer’s Wand
•  Iron and ironing board

Notions
•  Matching thread for construction
•  OESD Isacord Embroidery Thread
•  60 weight black bobbin thread
•  OESD AquaMesh Plus Stabilizer, 20” width
•  505 Temporary Spray Adhesive
•  Sharp Needle, size 90/14
•  Organ Titanium Sharp Embroidery needle,

size 90/14
•  Sewing thread to match denim

Finished Size: 14¼” x 42¼”
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Machine & Accessories
•  BERNINA V6 Embroidery Software
•  BERNINA Sewing & Embroidery Machine
•  Straight Stitch Plate
•  9mm Stitch Plate
•  Patchwork Foot with Guide #57D
•  Edgestitch Foot #10D
•  Teardrop Embroidery Foot #26
•  Large Oval Hoop
•  Jumbo Hoop (or resize the design as

needed to fi t the largest hoop available for
your embroidery system)

Instructions
Cut the Pieces
Cut three 10½” squares (A) using the
11” Square Ruler.

Cut four 10½” half square triangles (B) using
the Quarter Square Ruler.

Cut one 5¾” X 25” strip; cut into four
quarter square triangles (C) using the
Quarter Square Ruler.

Cut one 45” x 16” rectangle for backing
Cut three 9” squares for frayed edge
appliqué pieces.

Cut two 1½” x 16” on-grain strips for
binding.

Cut two 1½” x 45” on-grain strips for
binding.

Create the Designs
Center Flower
Open design CM101 in the BERNINA
Embroidery Software; Save As Center
Flower.

With design selected, open Object
Properties > General and change the width
to 185.0 mm and the height to 190.8 mm.
For the design to stitch out correctly for
this frayed edge appliqué technique, the
background leaves must stitch out before
the appliqué.

Ungroup the design.

In Color Film, select color 5; drag and drop
the selected tile between colors 1 and 2.
Save the design and Write to Machine.

End Flowers
Open design CM102 and Save As End
Flower.

With design selected, open Object
Properties > General and change the width
to 191.9 mm and the height to 173.5 mm.

Ungroup the design.

In Color Film, select color 3; drag and drop
the selected tile between colors 1 and 2.

Save the changes.

Save the design and Write to Machine.

Half Square Triangle Stippling
Open design BD422; Save As Half Square
Stippling.

With design selected, open Object
Properties > General and change the
width to 144.58 mm and the height to
271.44 mm.

Save the design and Write to Machine.
Print a template to use for design
placement.

Corner Quarter Square Stippling
Open design BD422; Save As Corner
Stippling.

With design selected, open Object
Properties > General and change the
width to 144.26 mm and the height to
138.99 mm.

Save the design and Write to Machine.
Print a template to use for design
placement.

Stitch the Embroidery
Hoop OESD AquaMesh Plus Stabilizer in
the Jumbo Hoop, paper side up.

Using the Embroiderer’s Wand, score and
remove the protective paper to expose the
adhesive.

Using a Target Sticker, mark the center of
the center block of the table runner.

Using the center position mark as a guide,
center the table runner on top of the
hooped stabilizer and smooth the fabric in
place without it.

Select the Center Flower design.

Attach the Jumbo Hoop to the machine
and ensure that the
design is centered.
Begin embroidering
the design. Note: The
fi rst color in the design
stitches the placement
line for the appliqué; the
second color stitches the
background leaves.

After the leaves are embroidered, spray the
light-colored side of a 9” square of denim
with the 505 Temporary Spray Adhesive.
Center over the stitched placement lines.

Finish stitching the embroidery.

Repeat, using the End Flower design on the
remaining two squares.

Trim away the fabric from the appliqué,
leaving approximately ¾” of fabric around
all edges. Note: To speed up the fraying of
the fabric later when the completed piece is
laundered, clip into the corners, ending at
the embroidered fl owers.

Construct the Table Runner
The BERNINA Quilter Program in BERNINA
Embroidery Software 6 was used to design
the Frayed Flowers Table Runner.

Using the BERNINA Patchwork Foot with
Guide #57D and the BERNINA Straight
Stitch Plate, piece the table runner as
shown in the diagram.
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Quilt the Table Runner
Spray one side of the batting with 505
Temporary Spray Adhesive,

Place on the light-colored side of the 16” x 45”
backing, sticky side down. Smooth in place
taking care not to stretch the fabric.

Spray the other side of the batting and apply it
to the back of the pieced table runner top.

Set up the machine for sewing using the
9mm Stitch Plate, Edgestitch Foot #10D, and
matching sewing thread in the needle and
bobbin.

Engage the BERNINA Dual Feed.

Stitch-in-the-ditch of all seams, starting in
the center of the table runner.

After all seams have been stitched, set up
machine for embroidery.

Use Target Stickers to mark the center
positions of the half square triangles and
quarter square triangles of the table runner.

Use the Jumbo Hoop to embroider the Half
Square Stippling design in the half square
triangles.

Use the Large Oval Hoop to embroider the
Corner Quarter Square Stippling design in
the quarter square triangles.

Apply the Binding
Fold the two 1½” x 16” and two 1½” x 45”
binding pieces in half lengthwise and press.

Set up the machine for sewing using
Edgestitch Foot #10D with the BERNINA
Dual Feed engaged and matching
construction thread in the needle and
bobbin.

Place one long edge of the table runner in
the fold of one 1½” x 45” binding piece with
about 1” extending beyond the top of the
table runner.

Move the needle position to the far left
Place the table runner and binding under
Edgestitch Foot #10D with the edge resting
against the center blade.

Edgestitch, starting ¼” from the top of the
table runner and ending ¼” from the lower
edge.

With the needle still to the left, guide the
blade of Foot #10D along the edgestitching
and sew a second – parallel – line of
stitching.

Repeat on the other long edge of the table
runner.

Repeat for the short ends of the table
runner. Note: Fold the binding tails out of
the way to avoid stitching on the already
attached binding.

Fray the Edges
Wash the table runner to remove the wash
away stabilizer.

Place the project in the dryer at a normal
setting; dry the table runner. The drying
process will cause the raw edges of the
denim to fray.

When the table runner is completely dry, trim
the frayed edges evenly. Additional fraying
will occur with subsequent laundering,
creating a beautifully “blooming” frayed
edge for the fl owers and binding.



This article was originally published in Inspiration magazine, No. 46, Spring 2010.
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Brighten up your room décor for summer with these coordinating 

decorative projects. We’ve included several ways to make the projects 

using free-motion stitching, your embroidery machine, and the 

BERNINA CutWork Tool and Software. Any way you stitch and 

cut, you’re sure to love these imaginative projects.

Blue Birds
 Magnolias&

Embroidery and CutWork fi les may be downloaded at 
www.bernina.com > Creative World > Inspiration > 46



Flower Planters
Finished size approximately 3½” x 4” or 2¾” x 6”

Materials
•  White and blue felt scraps
•  Wooden or aluminum sticks
•  Magnolia and Bird patterns from page 26
•  Embroidery designs from 4636-Stecker.ZIP

-  Magnolie_Stecker (.ART, ART50, EXP, PES)
-  Vogel_Stecker (.ART, ART50, EXP, PES)

•  CutWork design from CutWork_Gsteb_Spiegel_
Stecker_jumbo.ZIP

-  Gästeb_oval.Draw
•  BERNINA aurora, artista, or BERNINA 830 with

embroidery module (optional)
•  BERNINA CutWork Tool and Software (optional)
•  Edgestitch Foot #10
•  BERNINA Stitch Regulator #42 or Freehand

Quilting Foot #29/29C

Instructions

Step #1
Free-Motion Variation
Trace the magnolia and bird outlines on page 26. Free-motion
straight stitch the outline of the bird on blue felt. Thread-paint
the center of the fl ower on a layer of white felt, then free-motion
straight stitch straight the outline of the magnolia. Repeat, mirror-
imaging each shape.

Embroidery
Variation
Open the Magnolie_
Stecker embroidery
fi le. Duplicate the
fl ower, mirror image
it, and position
it below the fi rst
fl ower. Select
Arrange > Stitch
Sequence, and click
Yes to combine
colors and eliminate
excess thread
changes. Select an
appropriate hoop
size, position the
fl owers as needed,
and stitch them on
white felt.

Repeat for the
Vogel_Stecker
embroidery fi le and
stitch on blue felt.

CutWork Variation
Open the Gasteb_oval.Draw CutWork fi le. Select and Delete the
three magnolias and the second bird. Rotate the bird and increase
the height to 6” (15cm). Click on the Duplicate button and the

Mirror X button;
move the new bird
to the right of the
fi rst one by clicking
and dragging on the
outline of the bird.
Reposition birds as
needed to fi t inside
the hoop. Stitch/cut
the birds from blue
felt.

Open the Gasteb_
oval.Draw CutWork
fi le. Delete the two
birds and two small
magnolias, leaving
the large magnolia;
increase width to
approximately 4”
(10cm). Click on the
Duplicate button
and the Mirror X
button; move the
new fl ower above
the fi rst fl ower. Reposition fl owers as needed to fi t inside the hoop.
Combine cutwork and stitch fi les in the Sequence Manager. Stitch/
cut the magnolias from white felt.

Step #2
Trim embroidered pieces approximately 1/8” away from the stitching.
Mark an opening for the stick in the lower edge of each piece.
Place bird pieces wrong sides together. Using a straight stitch and
Edgestitch Foot #10, sew the pieces together close to the edge,
beginning behind the stick opening and ending in front of it. Repeat
for the magnolia pieces.

Step #3
Insert sticks and fi x in place with a bit of glue if desired.

22

T H R O U G H T H E N E E D L E



23

I S S U E 3 4S

2

Guest Book
Finished size approximately 8¾” x 11¼”

Materials
•  Two pieces of blue felt, each a generous 8¾” x 11¼”
•  Two pieces of white felt, each 11” x 13½”
•  Two pieces of cardboard, each just under 8¾” x 11¼”
•  Embroidery design from Cutwork_Gsteb_Speigel_Stecker_jumbo.ZIP

- Gasteb_Speigel_Stecker (.ART, ART50, EXP)
•  CutWork design Cutwork_Gsteb_Speigel_Stecker_jumbo.ZIP

-  Gästeb_oval.Draw
•  Yarn and embroidery thread in various colors
•  Metrosene Cordonnet/Topstitching thread
•  Topstitch needle, size 100/14
•  BERNINA aurora, artista, or BERNINA 830 with embroidery module (optional)
•  BERNINA CutWork Tool (optional)
•  BERNINA Stitch Regulator #42 or Freehand Quilting Foot #29/29C
•  Free-motion Couching Foot #43
•  Edgestitch Foot #10
•  3 binder rings or book screws (in craft or scrapbook shops, or online shops)
•  1 stack letter-size hole-punched paper
•  Punch pliers OR hole punch (there’s one in Eyelet Embroidery Set #82) and mallet
•  Glue

Instructions

Step #1
Draw and free-motion stitch branches onto one blue felt rectangle
with the BERNINA Stitch Regulator or Freehand Quilting Foot
#29/29C. Fill in the branch outlines using couching yarn or cord
with Free-Motion Couching Foot #43.

Step #2
Free-Motion Variation
Trace the three small magnolias on page 26. Free-motion straight
stitch the centers of the fl owers, then free-motion straight stitch the
outlines. Repeat for the two birds. Trim all shapes approximately
1/8” away from the
stitching.

Embroidery
Variation
Open Gasteb_
Speigel_Stecker.
ART fi le. Ungroup
the objects and
Delete everything
except the birds
and the three small
magnolias.

Select a hoop
appropriate for your
embroidery machine
and arrange the
birds and magnolias
in it. Embroider them
on white felt.

CutWork Variation
Download Gasteb-
oval.Draw. Select an
appropriately-sized
hoop and rearrange
shapes if desired.
Stitch/cut birds and
magnolias from
white felt.

Step #3
Attach the white shapes to one blue felt rectangle with a few
stitches and/or a bit of glue.

Step #4
Sew around the white felt rectangles with Edgestitch Foot
#10/10C, a Topstitch needle, and Cordonnet/topstitching thread.
Wrap the cardboard rectangles in the white felt, fi rst folding over
and trimming the corners; glue in place. Glue the embellished blue
rectangle to the front cover and the plain blue rectangle to the back
cover.

Step #5
Use a sheet of hole-punched paper to mark positions of holes
on the front and back covers. Using punch pliers or a hole punch
(from Eyelet Embroidery Set #82 or from a press-stud kit) and a
hammer, make holes in the book covers. Thread paper through the
rings and clip them closed.
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Mirror Decoration
Finished size = 10” x 10” (or selected frame size)

Materials
•  Mirror or picture frame, 10” x 10” or desired size
•  Blue heavyweight felt, several inches larger than the frame to be covered
•  White felt scraps
•  Yarn and embroidery thread in various colors
•  Metrosene Cordonnet/Topstitching thread
•  Topstitch needle, size 100/14
•  Mirror or picture frame
•  Glue
•  Embroidery design from Cutwork_Gsteb_Speigel_Stecker_jumbo.ZIP

-  Gasteb_Speigel_Stecker (.ART, ART50, EXP)
•  CutWork design Cutwork_Gsteb_Speigel_Stecker_jumbo.ZIP

- Gästeb_Spiegel_Stecker_jumbo.Draw
•  BERNINA aurora, artista, or BERNINA 830 with embroidery module (optional)
•  BERNINA CutWork Tool (optional)
•  BERNINA Stitch Regulator #42 or Freehand Quilting Foot #29/29C
•  Free-motion Couching Foot #43
•  Edgestitch Foot #10

Instructions

Step #1
Cut a rectangle of blue felt the same size as the picture frame.
Draw and free-motion stitch a branch onto the blue felt with the
BERNINA Stitch Regulator or Freehand Quilting Foot #29/29C. Fill
in the branch outline using couching yarn or cord with Free-Motion
Couching Foot #43. Stitch around the edge of the rectangle using
Cordonnet or Topstitching thread, Topstitch needle, and Edgestitch
Foot #10/10C/10D.

Step #2
Free-Motion Variation
Free-motion-embroider the outlines of the magnolias on the white
felt.

Embroidery
Variation
Open the Gasteb_
Speigel_Stecker.ART
fi le. Ungroup and
Delete all objects
except the last two
magnolias.

Select a hoop
appropriate for your
embroidery machine
and arrange the
magnolias in it.
Embroider the
fl owers on white felt.

CutWork Variation
Open the Gästeb_
Spiegel_Stecker_
jumbo.Draw
CutWork fi le. Break
Apart by selecting
the designs, right
clicking, and
choosing Break
Apart. Delete all
objects except the
last two magnolias.
Select a hoop
appropriate for your
embroidery machine
(such as artista 255
x 145 Oval Large
#44) and arrange
the magnolias in
it. Stitch/cut the
fl owers from white
felt.

Step #3
Cut out the magnolias. Attach to blue felt rectangle with a few
stitches. Glue the fi nished felt rectangle to the frame.
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Birds on a String
Finished size: Each bird is approximately 2¾” x 6”

Materials
•  Blue felt
•  Yarn or string in desired length
•  Yarn and embroidery thread in various colors
•  Metrosene Cordonnet/Topstitching thread (optional)
•  Topstitch needle, size 100/14 (optional)
•  Glue
•  Embroidery design from Cutwork_Vgel_Stecker_Hngeteil.ZIP

- Vogel_Stecker_Hangeteil (ART50, EXP)
•  CutWork design from Cutwork_Vgel_Stecker_Hngeteil.ZIP

- Vogel_Stecker_Hangeteil jumbo.Draw
•  BERNINA aurora, artista, or BERNINA 830 with embroidery

module (optional)
•  BERNINA CutWork Tool (optional)
•  Edgestitch Foot #10 (optional)

Instructions

Step #1
Free-Motion Variation
Trace pairs of mirror-imaged birds using the pattern for the Flower
Planters. Cut out the birds. Place bird pairs wrong sides together,
centered around the string; glue in place.

Embroidery Variation
Open and stitch the Vogel_Stecker_Hangetail fi le in the BERNINA
830’s Jumbo Hoop. Cut out the birds.

CutWork Variation
Open and cut the Vogel_Stecker_Hangetail fi le in the BERNINA
830’s Jumbo Hoop.

Step #2
Place bird pairs wrong sides together, centered over and
sandwiching the string; glue in place. Optional: Stitch around the
outer edges of the birds, close to the edges, using Edgestitch Foot
#10/10C, Cordonnet/topstitching thread, and a Topstitch needle.
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Flower Planter Bird

Book Cover Birds

Mirror Magnolias

Book Cover Magnolias

 Flower Planter Magnolia



Bold and beautiful, but just four easy blocks! Kitty
Yoshida’s Brooklyn Heights collection will add
a touch of contemporary glamor to any room
setting. Be sure to ask to see the

other Brooklyn Heights color stories!
Available at fine quilt shops everywhere.

For a FREE Albee Square pattern by Janet
Page Kessler, send a 44¢ SASE* to:
Brooklyn Heights, c/o Benartex, Inc.

1359 Broadway, Suite 1100
New York, NY 10018.

www.benartex.com
Benartex is the home of Fossil Fern and Triple-Dyed Balis.

*No checks please. Orders cannot be processed if checks are sent instead of a SASE. Current one ounce First Class postal rates apply at time of publication

©
2010
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P
age

K
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for
B
enartex,

Inc.



Add graphic punch to your summer dining area with these 
color-blocked placemats. Floral appliqués, outlined with 

rows of quilting echoing the shapes, add visual interest and 
texture to make a bold and colorful statement.

Supplies (for 6 placemats)
• ¼ yard each of two coordinating fabrics for appliqué background
• ½ yard each of two solid fabrics for main placemat section and fl ower 

centers
• 1/3 yard solid fabric for appliqué
• 13/8 yards backing fabric
• 13/8 batting
• 1 yard striped fabric for trim and binding
• 1 yard Steam-a-Seam 2
• Cotton thread for machine sewing
• Isacord embroidery thread
• Bobbin thread
• Open Embroidery Foot #20/20C
• Patchwork Foot #37/37D
• BERNINA Stitch Regulator #42
• Echo Quilting Foot #44
• Microtex/Sharp needle, size #80/12 
• OESD Ultra Clean & Tear Stabilizer
• 505 Spray and Fix Temporary Fabric Adhesive

Echo-Quilted 
Flower Placemats

A

r
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Cut the Fabric
• Cut three 7” x 14” rectangles from each ¼ yard of fabric (six total).
• Cut three 14” x 14” squares from each ½ yard of fabric (six total).
• Cut two 1¼”-wide strips from the striped fabric, cutting across 

the fabric width. Set the remaining striped fabric aside for the bias 
binding. Fold each strip in half lengthwise and press; cut a total of 
six 14”-long strips from the folded strips.

• Cut six 15” x 20” rectangles from the backing fabric.
• Cut six 15” x 20” rectangles from the batting.

Appliqué the Flowers
• Trace 16 fl ower shapes onto the paper side of the fusible web / 

Steam-a-Seam2. 
• Trace 16 ovals for the fl ower centers. 
• Cut out the fl owers and ovals, leaving approximately ¼” margin 

beyond the drawn lines. 
• Fuse fl owers to the wrong side of the appliqué fabric. 
• Fuse the oval centers to the remainder of the main placemat fabric. 
• Cut out fl owers and fl ower centers along the drawn lines. 

• Place a 7” x 14” fabric 
rectangle on one end of 
each piece of batting, 
using 505 Temporary 
Fabric Adhesive to hold 
the layers together. 

• Remove the backing 
paper and fuse 2½ 
fl owers to each fabric 
rectangle.

• Place a layer of Ultra Clean & Tear Stabilizer behind each piece of 
batting. 

• Fill a bobbin with the bobbin thread and place in the bobbin case, 
threading it for embroidery.

• Thread the needle with embroidery thread. 

• Attach Open Embroidery Foot #20/20C and select 
artista stitch #427 or another stitch of your choice.

• Mirror Image the stitch right/left and place the needle in 
the far right position. (If using a machine with 9mm stitch 
width, narrow the stitch width to 7.2mm.)

• Place the edge of the appliqué 
just inside the right toe of 
the foot. Stitch the fl owers in 
place. 

• Change the needle thread color to appliqué the fl ower centers. 

• Select artista stitch #418 or another stitch of your 
choice.

• Place the needle in the center position. (If using a 
machine with 9mm stitch width, narrow the stitch width 
to 6.8mm.)  Appliqué the fl ower centers. 

Insert the Center Strip
• Thread the machine with sewing 

thread and attach Patchwork Foot 
#37/37D. 

• Place a striped strip along the 
inside edge of the appliquéd fabric 
rectangle, raw edges even, and baste 
in place using a scant ¼”-wide seam 
allowance. 

• Place the appliquéd piece on top 
of the backing fabric, using 505 
Adhesive to hold the layers together.

• With raw edges even, place a main 
fabric square right sides together with 
the appliquéd rectangle, with raw edges even. Stitch with a ¼”-wide
seam allowance.

• Open out the main 
fabric and press.

Quilt the Placemat
• Attach the BERNINA 

Stitch Regulator and 
quilt the main part of the 
placemat. 

• Attach Echo Quilting 
Foot #44. Echo quilt 
around the fl ower 
shapes, with the center 
guide of the foot riding 
along the outside edge 
of each fl ower.

• Echo quilt around the 
fl owers again, with the 
second guide of the 
foot ride riding along 
the outside edge of the 
fl ower. 

• Continue echo quilting 
the fl owers as desired. 

Bind the Placemats
• Cut 2¼”-wide bias 

strips from the 
remainder of the striped 
fabric. Join the strips 
with bias seams to 
make six binding strips, 
each at least 80” long. 
Fold each strip in half 
lengthwise with wrong 
sides facing and raw 
edges even; press. 

• Attach Patchwork 
Foot #37/37D to the 
machine and sew a 
bias strip around each placemat, using a ¼”-wide seam allowance. 
Miter the corners as you reach them. 

• Turn the bias binding 
to the back of the 
placemats and hand-
stitch in place.
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Prepare the Fabric Pieces
To duplicate by blouse, open the My Label 3D Fashion Pattern
Software and select the Tailored Shirt from the Styles Drawer. Using
the “Print Selected” icon from the Toolbar, print out only the Pattern
Front, Pattern Back, and the Collar Stand.

Without a set-in sleeve, the length of the shoulder seam may be too
long. I shortened the shoulder seam of my blouse pattern by 1½”, as
shown in the illustration.

For armhole facings,
use pattern tracing
paper to create a set
of 2½”-deep armhole
facings using the new
cutting lines. Bias
binding is another
option for fi nishing the
armholes.

Cut the Back, Collar
Stand, and Left Front
from your fabric as
directed in the My
Label directions. Cut
out the Right Front as
shown in the diagram,
adding 5” additional
fabric to the left of the
Center Front line for the
buttonhole placket.

          Little   Little 
WhimsyWhimsy
Insert aInsert a

BY JEANNE DELPIT

Have your ever fallen
in love with a piece of
trim or fabric that you
just had to have even
though you weren’t quite sure
what to create with it? During a
shopping trip to a fabric store in
St. Gallen, Switzerland, a length of
gorgeous embroidered insertion ended

up in my shopping basket! After a long courtship, I fi nally decided
to modify the My Label Tailored Shirt to a sleeveless version with a
buttonhole placket and use my coveted insertion to add a bit of whimsy to
the garment.
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Mark the front
and back darts
as marked, but
form soft tucks by
stitching only stitch
2½” above and
below the waistline.

Note: My Swiss
insertion was 1”
wide, and I added
¼” entredeux on
each side, for a total
width of 1½”. The
instructions that
follow are based
on 1½”-wide total
insertion width.

Create the Back Panel
Mark a line along the center of the Back fabric piece. Measure the length
of the Back and multiply by 5; this is the total yardage of 1½”-wide
insertion needed for the blouse black, front placket, and collar.

Cut 3 strips of insertion, each the length of the Back plus 1½”,
making sure that the design of each strip begins and ends at the
same spot in the design.

Place the strips right sides together and use Edgestitch Foot #10D
with the BERNINA Dual Feed to join them, guiding the blade of
the foot in the channel at the edge of the entredeux. Press seam
allowances open. Or place the strips side-by-side, butting the edges
together at each side of the guide, and zigzag them together.

Measure the fi nished width of the pieced Insertion from seam line
to seam line and divide the measurement in half. Mark lines this
distance from each side of the marked center back line (shown in
yellow). Cut away the center back ½” inside the marked lines.

With right sides together, place the insertion stitching line on top of
the marked line and stitch them together. Repeat for other edge.

For a clean fi nish, trim away the excess fabric and zigzag the raw
edges together. Select a zigzag stitch (stitch length = 1.0 and stitch
width = 3.0) and move the needle two steps to the right or left as
needed so that the “zig” falls off the fabric edge and the “zag” is in line
with the previous line of stitching. Press seam allowances toward sides.

Create the Buttonhole Placket
Cut a strip of insertion the length of the center front plus 2”.

Identify and lightly mark the center front on both the left and right
Fronts (red line in photo, which shows the right Front). Mark the fold
line on each Front. Set the left Front aside for now.
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Place the insertion on top of the fold line on the right Front, with right
sides together.

Stitch in place using Dual Feed Edgestitch Foot #10D.

Fold the insertion toward the center front, covering the center front
line, and press. The wrong side of the insertion will be against the
right side of the Front.

Measure the width of the insertion from stitching line to stitching line.

Mark a line that distance to the left of the insertion stitching line. Note
that the new line is to the opposite side of the center front. This will
be the new placement line for stitching.

Mark a line ½” to the right of the line just drawn. Cut the Front along
this line and use the cut-away section for the placket extension.

Place the placket extension on the Front, right sides together,
aligning the placement line with the insertion stitching line.

Stitch together. Trim away the excess fabric and zigzag the edges
together. Press the seam allowance toward the side seam.
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Place the Right Front right side down on a fl at surface. Mark a line
1¾” from the outer edge of placket. Fold and press along this line,
from neckline to hem, with wrong sides together.

Fold the entire placket back on itself, keeping the 1¾” fold in place.
Press so that edge of the insertion becomes the front edge of the
blouse as indicated by the arrows in the photo.

With the right side of the insertion facing up, stitch through all layers
using the inner edge of the entredeux as a guide.

Place the Right Front face down and fold the placket to the left.
Press.

Mark the buttonhole placement and stitch the buttonholes. Due
to the bulk of the Collar Stand, do not make a buttonhole at the
neckline.

Use the remaining pieces of insertion to trim the outer Collar Stand.

Construct the Blouse
Construct the blouse following the instructions in My Label
Instructions tab.

Tip: You may want to create French seams for the side and shoulder
seams of your blouse, concealing the raw edges. Place fabric
pieces wrong sides together and use Patchwork Foot #37D to
stitch ¼” from the raw edges. Trim the seam allowances close
to the stitching. Fold pieces right sides together along the seam
line. Use Dual Feed Reverse Pattern Foot #1D or Dual Feed
Clear Foot #34D to stitch a second seam, this one 3/8” from the
outside edge.

Tip: Use Zigzag Hemmer #66 for a neatly-fi nished turned hem.

Tip: Use Button Sew-On Foot #18 and a button sew-on stitch #60
to attach buttons to the Left Front.



I’d Rather Be Stitchin’
    than In the Kitchen!

BY PAULA HARMON
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Supply List

Fabric or ready-made item to embellish

OESD Fusible PolyMesh Stabilizer

OESD Lightweight Tear-Away Stabilizer

505 Temporary Spray Adhesive

Three colors of Isacord Embroidery Thread

Erasable fabric marking pen or pencil

BERNINA Sewing Machine

Reverse Pattern Foot with Clear Sole #34/34C/34D

Sharp Needle Size 75/11

Prepare the Fabric
•  Following the manufacturer’s instructions, apply OESD Fusible PolyMesh to the wrong side of

your fabric or the ready-made item in the area to be stitched. Stabilize the entire area where
the stitching will occur. This will prevent fabric distortion during the stitching process.

•  Using an erasable marking pen, draw a line the entire length of the fabric or item tobe stitched.Mark a second line perpendicular to the fi rst. This line is the starting point for
each row of stitching.

•  Cut a piece of OESD Lightweight Tear-Away Stabilizer the length of the area to be sewn.
Spray the wrong side of the stabilizer with 505 Temporary Spray Adhesive and apply it to
the wrong side of the fabric to be stitched.



Repeat on the side of the other triple straight stitches, engaging the Mirror Image function of your

machine to reverse the pattern.

Change to the third color of Isacord thread. Locate

and select an Arrow Stitch (#401 on the artista & 8

Series machines). Stitch this pattern along the outer

sides of the band of stitching. Remember to use the Pattern

End feature to complete your line of stitching.

Repeat on the side of the other triple straight stitches, engaging the Mirror Image function of y

machine to reverse the pattern.

Change to second color of Isacord thread. Locate and select stitch #106. Sew this stitch over the

center alignment line. Remember to engage Pattern End

when you are ready to sew your last pattern.

Locate and select stitch #136. Sew with the edge of the

presser foot aligned with one of the Triple Straight Stitch

rows. Remember to engage Pattern End when you are

ready to sew your last pattern.

sacord thread. Locate and select stitch #106. Sew this stitch over the

mber to engage Pattern End

Keeping the left side of the presser foot lined up with the center line, stitch the length of the
line until you have almost reached the end of the fabric. When you are ready to stop sewing,
engage the Pattern End button on your machine. This will tell the machine to stop sewing at
the end of the complete stitch pattern.

Repeat on the other side of the center line.

Locate and select the Triple Straight Stitch (#6 on theartista and 8 Series machines). Stitch along the outer sideof the stitches sewn above. Use the red mark one thecenter of Clear Foot #34 for exact alignment of the line of stitches.
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Keeping the left side of the presser foot lined up with the center line, stitch the length o
line until you have almost reached the end of the fabric. When you are ready to tengage the Patt E

At the Machine
Locate and Select Stitch #302 on your machine. Line up

the left side of Clear Foot #34 with the line drawn along the

length of the fabric. Notice that the foot has a red mark on

each side of the needle opening. These marks indicate the exact

location of the needle. Align these marks with the crosswise

placement line. Doing this for each line of stitching will ensure

that all of them begin at the same place.
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ALEX ANDERSON RICKY TIMS



#93-4011 
Spring Heart 
Collection

#93-4005 
Fly Away Butterflies

#93-4006
Spring is at Your Door

#93-4008 
Camille & Chloe

#93-4010 
Spring Welcome

CINNAMON PATCH—Folk Art Felt Patterns
Irish-born Parisian artist Marianne Byrne-Goarin is the creator of Cin-

namon Patch. Her simple patterns conjure up warm thoughts of cozy 

homes and beautiful gardens.

 A Brewer Exclusive—Cinnamon Patch projects are accessible for 

stitchers of all skill levels.  

#93-4002 
Alphabet Patchwork

#93-4003 
In My Folkart Garden

#93-4004 
Birdhouse Pennyrug

#93-4007
Garden of My Heart

#93-4009 
Folkart Butterflies

#NW001/NW002

BR
EW

ER EXCLUSIVE 

Brewer
Quilting & Sewing SuppliesCinnamon Patch patterns are available at your independent  

sewing and quilting stores and at participating Bernina dealers. 

To find a dealer near you, call us toll-free at 800-676-6543. 

WOOL FELT
Cinnamon Patch patterns work perfectly with the wool felt from 

National Nonwoven—it’s thick, soft, and pleasant to the touch. 

This superior-quality felt can be embroidered and appliquéd. 

Choose your favorite  
Cinnamon Patch project  
and get started today!




